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System Storage DS3950 Quick Start Guide

This Quick Start Guide describes the basic procedure for installing, cabling, and configuring the IBM®

System Storage™ DS3950 storage subsystem (Machine Types 1814-94H and 1814-98H).

For educational information about the DS3950 and other IBM System Storage products, go to
http://ibmdsseriestraining.com/.

For the latest information about IBM System Storage disk storage systems, go to http://www.ibm.com/
systems/support/storage/disk.

For detailed information about the storage subsystem, see the IBM System Storage DS3950 Storage
Subsystem Installation, User’s, and Maintenance Guide. For safety information, see the multilingual IBM
Safety Information document on the Documentation CD.

Installation guidelines
Before you install the storage subsystem in a rack cabinet, review the following guidelines:
v Two or more people are required to install devices 18 kg (39.7 lb) or heavier in a rack cabinet.
v Make sure that the room air temperature is below 35°C (95°F).
v Do not block any air vents; usually 15 cm (6 in.) of space provides proper airflow.
v Do not leave open spaces above or below an installed storage subsystem in your rack cabinet. To help

prevent damage to storage subsystem components, always install a blank filler panel to cover the open
space and to help ensure proper air circulation.

v Install the storage subsystem only in a rack cabinet with perforated doors.
v Plan the device installation starting from the bottom of the rack cabinet.
v Install the heaviest device in the bottom of the rack cabinet.
v Do not extend more than one device out of the rack cabinet at the same time.
v Remove the rack doors and side panels to provide easier access during installation.
v Connect the storage subsystem to a properly grounded outlet.
v Do not overload the power outlet when you install multiple devices in the rack cabinet.
v Install the storage subsystem in a rack cabinet that meets the following requirements:

– Minimum depth of 70 mm (2.76 in.) between the front support flange and inside of the front door.
– Minimum depth of 157 mm (6.18 in.) between the rear support flange and inside of the rear door.
– Minimum depth of 718 mm (28.27 in.) and maximum depth of 762 mm (30 in.) between the front

and rear support flanges to support the use of the cable-management arm.

Use safe practices when lifting.

≥18 kg (39.7 lb) ≥32 kg (70.5 lb) ≥55 kg (121.2 lb)

http://ibmdsseriestraining.com/
http://www.ibm.com/systems/support/storage/disk
http://www.ibm.com/systems/support/storage/disk


Inventory list
The following illustration and inventory list show the items that you need to install the storage
subsystem in the rack cabinet. If any items are missing or damaged, contact your place of purchase.

Notes:

1. The illustration might differ slightly from your hardware.
2. Depending on your DS3950 order, your shipping box might contain additional materials not shown in

the following illustration.
3. The Small Form-factor Pluggable transceivers (SFPs) are preinstalled in the Fibre Channel host ports.
4. The host-interface cables, Ethernet cables, Fibre Channel signal cables, and iSCSI signal cables are not

shown in the following illustration.
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After you unpack the DS3950, verify that you have the following items:
v Enhanced disk drive modules (E-DDMs) or blank trays (16) (Your storage subsystem might come with

up to 16 drives.)
v RAID controllers (2)
v AC power supply and fan units (2)
v Fibre Channel signal cables (2)
v iSCSI signal cables (2) (model 98H only)
v Battery units (2)
v Power cables (2 rack jumper line cords)
v Diagnostic wrap plug/coupler (1)
v Serial cable adapter (1)
v Rack-mounting hardware kit (1), including:

– Rails (2) (right and left assemblies)
– M5 black hex-head slotted screws (12)
– M4 screws (4)
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– Washers (8)
v 8 Gbps SFPs (4)

Note: The SFPs are preinstalled in the DS3950.

Important: The DS3950 does not ship with region-specific ac power cords. You must obtain the
IBM-approved power cords for your region. See the IBM System Storage DS3950 Storage
Subsystem Installation, User’s, and Maintenance Guide for more information.

Tools
Before you install the storage subsystem, the installation area must have an Internet connection, and you
must have the following tools:
v A cart to hold the storage subsystem and its components
v Labels for the cable connectors
v A medium flat-blade screwdriver
v A No. 2 Phillips screwdriver or an M5 hex driver
v Anti-static protection

Installation overview
The installation of the storage subsystem involves the following procedures:
1. “Unpacking the storage subsystem” on page 4
2. “Installing the support rails” on page 5
3. “Removing the storage subsystem and expansion enclosure components” on page 6
4. “Installing the storage subsystem and storage expansion enclosures in the rack cabinet” on page 7
5. “Installing the cables” on page 8
6. “Turning on the power” on page 14
7. “Installing the software” on page 15
8. “Discovering and setting up the storage subsystem” on page 16
9. “Obtaining information from the IBM Support Web site” on page 16

10. “Updating the storage subsystem firmware” on page 17
11. “Configuring the storage subsystem” on page 17
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Unpacking the storage subsystem

Statement 4:

≥ 18 kg (39.7 lb) ≥ 32 kg (70.5 lb) ≥ 55 kg (121.2 lb)

CAUTION:
Use safe practices when lifting.

To unpack the storage subsystem, complete the following steps:
1. With the help of one other person, remove the storage subsystem from the shipping box and place it

on a cart, table, or other raised surface.
2. Check the storage subsystem to make sure that you received all the necessary parts. See the

“Inventory list” on page 2 section for the parts that are included with the storage subsystem.
3. Take the left and right support rails and the M5 screws and proceed to the “Installing the support

rails” on page 5 section.
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Installing the support rails

Support rail
adjustment screws

Left
support
rail

Right
support
rail

M5
screws

Notes:

1. For proper weight distribution, install the support rails from the storage subsystem ship group in the
lower portion of the rack cabinet.

2. Make sure that you allow room above and below the storage subsystem for storage expansion
enclosures.

3. The support rails are marked “R” and “L” for right and left.

To install the left and right support rails in the rack cabinet, complete the following steps. Use the front
and rear rack-mounting templates on pages 18 and 19 to align the support rails with the correct rack
holes.
1. Starting with the left support rail, loosen the two rail adjustment screws. The adjustment screws are

used to lock the support rails at a certain length.
2. Hold the front of the left support rail against the inside of the front rack cabinet support flange, and

extend the rear of the support rail until it makes contact with the rear rack cabinet support flange.
The alignment pins at the rear of the support rail slide into the holes at the rear of the rack cabinet.

3. From the front of the rack cabinet, with the support-rail flanges positioned inside the rack cabinet
support rail assemblies, tighten only the lower M5 screw completely with a Phillips screwdriver.
Install the upper M5 screw and tighten it halfway.

Notes:

a. Do not tighten the upper M5 screw completely until you install the storage subsystem in the rack
cabinet.

b. Make sure that you use a washer when you install an M5 screw through a square hole on a
rack-mounting flange.

4. From the rear of the rack cabinet, tighten the two M5 screws halfway with a Phillips screwdriver.
Attention: Make sure that the screws are tight enough to support the weight of the storage
subsystem. Do not completely tighten the screws until you install the storage subsystem in the rack
cabinet.

5. Tighten the two rail adjustment screws with a medium flat-blade screwdriver.
6. Repeat steps 2 through 5 for the right support rail.
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Removing the storage subsystem and expansion enclosure
components
Remove the controllers, hot-swap hard disk drives, ac power supply, and fan units before you lift the
storage subsystem. This reduces the weight of the DS3950 during installation. Each component in the
back of the DS3950 and EXP395 is held in place by a lever that has a locking latch.

To remove the components, complete the following steps.

Lever

Latch

1. Release the lever:
a. Squeeze the latch and pull the lever open 90° (so that the lever is horizontal). The latch is an

orange-colored tab on the lever.
b. Slowly pull the lever away from the chassis to remove the module. Label each controller and

expansion enclosure environmental services monitor (ESM). Controller A and ESM A are in the
upper-left slot, and controller B and ESM B are in the lower-right slot.

Latch

2. Remove the hard disk drives:
a. Label the hard disk drives so that you can replace them in their original order.
b. Release the latch on the E-DDM by pressing on the inside of the bottom of the tray handle.
c. Lift the closed latch to its open position. When the latch is open, it is at a 90° angle to the front of

the E-DDM.
d. Pull the E-DDM out of its bay.
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e. Repeat steps 2b on page 6 through 2d on page 6 for each E-DDM.
3. If you have storage expansion enclosures, remove the enclosure components before you install them.

See the Installation, User’s, and Maintenance Guide that came with the enclosures for more information
about removing the components.

Installing the storage subsystem and storage expansion enclosures in
the rack cabinet

Statement 4:

≥ 18 kg (39.7 lb) ≥ 32 kg (70.5 lb) ≥ 55 kg (121.2 lb)

CAUTION:
Use safe practices when lifting.

To install the storage subsystem, complete the following steps:
1. Slide the rear of the storage subsystem onto the support rails.
2. Align the front mounting holes on each side of the storage subsystem with the mounting holes on the

front of the support rails.
3. Install and tighten the four M5 screws in the support holes on each side of the front of the storage

subsystem.

M5 screws

M4 screws

4. Install and tighten the four M4 screws to secure the rear of the storage subsystem to the rack cabinet.
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5. Tighten the two upper M5 screws, that secure the support rails to the front of the rack cabinet, that
you installed in step 3 on page 5.

6. Tighten the four M5 screws, that secure the support rails to the rear of the rack, that you installed in
step 4 on page 5.

Installing the cables

Statement 3:

CAUTION:
When laser products (such as CD-ROMs, DVD drives, fiber optic devices, or transmitters) are
installed, note the following:

v Do not remove the covers. Removing the covers of the laser product could result in exposure to
hazardous laser radiation. There are no serviceable parts inside the device.

v Use of controls or adjustments or performance of procedures other than those specified herein
might result in hazardous radiation exposure.

DANGER

Some laser products contain an embedded Class 3A or Class 3B laser diode. Note the following.

Laser radiation when open. Do not stare into the beam, do not view directly with optical
instruments, and avoid direct exposure to the beam.

Use the following illustrations to identify the parts, LEDs, and input/output ports on the front and rear
of the DS3950 storage subsystem.

Note: The following illustrations might differ slightly from your DS3950 hardware.
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fault
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Global
power
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The following illustration shows the back view of DS3950 Model 94H controllers with two Fibre Channel
drive channels and two Fibre Channel host expansion channels per controller.
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The following illustration shows the back view of DS3950 Model 98H controllers with two Fibre Channel
drive channels, two Fibre Channel host expansion channels, and two iSCSI host expansion channels per
controller.

Controller B

Controller A

Fibre Channel
host channels

Ethernet
ports

Serial
port

Enclosure ID

Dual-ported
drive channel Enclosure ID

Ethernet
ports

Serial
port

Dual-ported
drive
channel

iSCSI
host
channels

Power-fan
canister

Controller
canister

Fibre Channel
host channels

iSCSI
host
channels

9



Cabling a host server and storage subsystem controllers
Before you cable the storage subsystem to a host server, determine which method of storage-subsystem
management that you want to use. You can manage the storage subsystems with either an in-band
management connection or an out-of-band management connection. The DS3950 supports redundant
direct Fibre Channel connections and indirect (switch-enabled) iSCSI connections to a maximum of four
hosts. For more information about cabling a host server to the DS3950, see the IBM System Storage DS3950
Installation, User’s, and Maintenance Guide that came with the storage subsystem.

Notes:

1. The DS3950 does not support direct connections from the host systems to the iSCSI ports on the
storage subsystem.

2. The DS3950 does not support connections to both iSCSI and Fibre Channel ports from the same host
system.

To cable the host server and the storage subsystem controllers for in-band management, complete the
following steps:
1. The Small Form-factor Pluggable transceivers (SFPs) are preinstalled in the Fibre Channel host ports.

Make sure the SFPs are seated completely in the host ports.
2. Remove any extra SFP transceivers from the host ports that will not be used. If a black, plastic plug is

in the SFP transceiver, remove it.
3. Choose a direct topology, a switch or fabric topology, or a mixed topology for your configuration.

Fore more information about host connection topologies, see the IBM System Storage DS3950
Installation, User’s, and Maintenance Guide that came with the storage subsystem.

Important: The DS3950 does not support connections to both iSCSI and Fibre Channel ports from the
same host system.

4. After you cable each host and controller connection, label each end of each cable with information
about its connection.

5. Repeat steps 1 through 4 for every controller and host channel that you plan to use.
6. Make sure that the Link Rate switch is set to the 4 Gbps data-transfer rate. If the link rate is 2 Gbps,

make sure that the power to the storage subsystem is turned off; then, move the switch to the 4 Gbps
(left) position. To locate the Link Rate switch, see the illustration of the front of the storage subsystem
on page 8.

7. See “Cabling the storage subsystem and storage expansion enclosures” on page 11 for information
about cabling the storage subsystem with EXP395 and EXP810 storage expansion enclosures.

In-band and out-of-band management
In-band management requires host-agent software that you install on the host server. In-band
management uses existing host connections, along with the Storage Manager Agent. No additional
cabling is necessary. For more information, see the IBM System Storage DS Storage Manager Installation and
Host Support Guide

Out-of-band management uses Ethernet connections from a management station to each controller. You
must install at least one management station. The management station can be the host server or a
workstation on the Ethernet network. To use Ethernet cabling (for out-of-band management only),
complete the following steps:
1. Connect one end of the Ethernet cable to the Ethernet port 1 connector on controller A. To locate the

Ethernet ports, see the illustration of the rear of the storage subsystem on page 8.
2. Connect the other end of the Ethernet cable to the applicable network connection.
3. Repeat steps 1 and 2 for controller B.
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Cabling the storage subsystem and storage expansion enclosures
The DS3950 supports EXP395 and EXP810 storage expansion enclosures. To attach an EXP810 storage
expansion enclosure, you must purchase the applicable feature option. For more information about
cabling storage expansion enclosures, see the IBM System Storage DS3950 Installation, User’s, and
Maintenance Guide that came with the storage subsystem.

For maximum redundancy and drive-loss protection, use the information in this section to install cables.
To cable the storage subsystem and storage expansion enclosures, complete the following steps:
1. If not already installed, insert an SFP module in each of the required EXP810 or EXP395 drive ports.

Remove extra SFPs from drive ports that will not be used.

Note: Install a minimum of two drives per storage expansion enclosure. Start with the left slot.
2. Connect a fiber-optic cable from port 2, drive channel 1 of controller A in the storage subsystem to

port 1B on the left ESM board of the first storage expansion enclosure.
3. Connect a fiber-optic cable from port 1, drive channel 2 of controller B to port 1B on the right ESM

board of the first storage expansion enclosure.

Port 2, drive channel 1

Port 1, drive channel 1

Port 1, drive channel 2
Port 2, drive channel 2

1A1B

1A 1B

Storage
subsystem
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4. To connect a second storage expansion enclosure, connect a fiber-optic cable from port 1, drive
channel 1 of controller A in the storage subsystem to port 1B on the left ESM board of the second
storage expansion enclosure. Then, connect a fiber-optic cable from port 2, drive channel 2 of
controller B to port 1B on the right ESM board of the second storage expansion enclosure.

Port 2, drive channel 1

Port 1, drive channel 1

Port 1, drive channel 2
Port 2, drive channel 2

1A1B

1A 1B

1A1B

1A 1B

Storage
subsystem
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Use the following diagram to cable the maximum of six storage expansion enclosures.
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Turning on the power

Statement 5:

CAUTION:
The power control button on the device and the power switch on the power supply do not turn off the
electrical current supplied to the device. The device also might have more than one power cord. To
remove all electrical current from the device, ensure that all power cords are disconnected from the
power source.

1

2

Important: You must follow the power sequence in the order shown in the following procedure. To
establish power redundancy for enclosures with two power supplies, use at least two power
distribution units (PDUs) in the rack cabinet. Split the power connections from each enclosure
into the separate PDUs. Then, connect the PDUs to external power receptacles that are on
different circuits.

To turn on the storage subsystem power, complete the following steps:
1. Connect a power cord to each power supply in the storage subsystem.
2. Connect the other end of each power cord to the power receptacle.

Important: Before you turn on the power to the DS3950 storage subsystem, it must be populated with
at least two hard disk drives. If at least two hard disk drives are not installed in the
DS3950, an insufficient load to the enclosure power supplies might cause them to
intermittently appear as failed, falsely indicating the power supplies are bad. All of the
hard disk drives in the DS3950 storage subsystem and the connected storage expansion
enclosure or enclosures must contain no prior configuration data.

3. Turn on the power to the switches, if applicable.
4. Turn on both power switches on all of the attached storage expansion enclosures, and wait 60

seconds.
5. Turn on both power switches on the storage subsystem.

Note: When you turn off the power to the storage subsystem, complete the preceding steps in reverse
order. Turn off the power to the storage subsystem first; then, turn off the power to the storage
expansion enclosures.
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Installing the software
There are two types of computers that are associated with the storage subsystem. Hosts send
input/output (I/O) to the storage subsystem LUNs. Management stations manage the storage subsystem.
A computer can function as a host, a management station, or both. Use this section to install the DS
Storage Manager software on a management station or a host.

Note: The latest version of the DS Storage Manager software for your operating system is on the IBM
Support Web site. See “Obtaining information from the IBM Support Web site” on page 16 for
more information. The version of the software on the DS Storage Manager DVD that came with
your storage subsystem might not be the latest version.

Installing DS Storage Manager on a management station
To install the DS Storage Manager software on a management workstation, complete the following steps:
1. If you have access to the Internet, download the latest version of the DS Storage Manager software

from the IBM Support Web site (see “Obtaining information from the IBM Support Web site” on page
16 for more information). If you do not have Internet access, insert the DS Storage Manager DVD on
the management workstation and locate the applicable directory for your operating system.

Note: The type of operating system that the management station runs is the directory that you must
locate on the DS Storage Manager DVD. For more information, see the operating-system and
device-river readme files on the DS Storage Manager DVD.

2. Double-click the SMIA executable file. Follow the instructions in the setup wizard, and make sure that
you select one of the following options when you are prompted:
v Click Management Station if the computer will be used only as a management station.
v Click Typical (full installation) if the computer will be used as a management station and a host.

3. If this computer is the only computer designated as a monitor, select Automatically Start Monitor
when you are prompted.

Note: If additional computers will manage the storage subsystem, do not click Automatically Start
Monitor when you set up those additional computers. Instead, click Do Not Automatically
Start the Monitor when you are prompted. Otherwise, multiple alert notifications will be sent
when there are problems with the storage subsystems.

Installing software on a host
To install the software on a host, complete the following steps:
1. Check the host bus adapter (HBA) BIOS and device-driver versions for your current HBAs. If

necessary, update them to the current level shown on the IBM Support Web site before you install the
software (see “Obtaining information from the IBM Support Web site” on page 16 for more
information). The DS Storage Manager DVD also contains HBA BIOS, device drivers, and readme files
for IBM HBAs. The HBA BIOS, device drivers, and readme files are located in the HostAdapter
directory on the DS Storage Manager DVD.

Notes:

a. The BIOS and device drivers for your HBAs should be obtained directly from the IBM Support
Web site. See “Obtaining information from the IBM Support Web site” on page 16 for more
information.

b. For Microsoft® Windows® installations, install the StorPort version of the HBA device driver.
2. Install the multipath driver to manage the paths from the host HBAs to the storage subsystem

controllers. For more information, see the IBM System Storage DS Storage Manager Version 10 Installation
and Host Support Guide.
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Discovering and setting up the storage subsystem
To discover and set up the storage subsystem, complete the following steps:
1. Start the DS Storage Manager software from your management station. The Enterprise Management

and Confirm Initial Automatic Discovery windows open.
2. Select Automatic Discovery from the Enterprise Management Window to discover the storage

subsystem. After the initial automatic discovery is complete, the Enterprise Management window
displays all hosts and storage subsystems that are attached to the local subnetwork.

Note: To discover storage subsystems that are outside of the local subnetwork, click View > Task
Assistant > Add Storage Subsystems.

3. Click Rename the Storage Subsystem. Use the serial number of the DS3950 as the first part of the
subsystem name. The host name has a maximum of 30 characters.

4. Click Locate the Storage Subsystem. A blue LED flashes on the front of the selected storage
subsystem. Label the storage subsystem with its associated name.

Note: If the storage subsystem is not discovered automatically, add the storage subsystem manually
by typing the IP address.

5. Highlight the storage subsystem and click Tools > Manage Storage Subsystem to open the Subsystem
Management window and the Task Assistant.

6. If the storage subsystem is not in Optimal state, click the Recover from Failure icon in the Task
Assistant. Follow the steps in the Recovery Guru. When the subsystem is Optimal, close the Task
Assistant.

7. In the Subsystem Management window, click Storage Subsystem > View Profile. Click the Controller
Firmware, NVSRAM, ESM Firmware, Drive Product ID, and Firmware Versions tabs, and write
each number in the following table for future use.

Controller firmware:

NVSRAM:

ESM firmware:

Drive product ID:

Firmware versions:

8. Save the profile for future use and close the profile window.

Note: Save a copy of the storage subsystem profile and the Collect All Support Data bundle when
you make configuration changes to the storage subsystems.

Obtaining information from the IBM Support Web site
The IBM System Storage documentation that is described in this Quick Start Guide and other IBM System
Storage information is on the IBM support Web site. To access the latest documentation, downloads, and
other technical updates on the IBM support Web site, complete the following steps.

Note: Changes are made periodically to the IBM Web site. Procedures for locating firmware and
documentation might vary slightly from what is described in this document.

1. Go to http://www.ibm.com/systems/storage/support/.
2. Under Select your product, in the Product Family field, click Disk systems.
3. In the Product field, click DS3950, and then click Go.
4. Under Support & downloads, click the applicable support category.
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Note: For detailed information about device-driver and firmware versions, make sure that you read the
readme files that are posted with each package.

Updating the storage subsystem firmware

Note: The DS Storage Manager host code and HBA BIOS and device driver are current, if you completed
all the steps in “Installing the software” on page 15.

In the Subsystem Management Window, click Advanced > Maintenance > Download. Select the
following options in the order listed:
1. Controller firmware
2. Controller NVSRAM
3. ESM firmware
4. Drive firmware

Configuring the storage subsystem
In the Subsystem Management Window, click View > Task Assistant. If the storage subsystem is
Optimal, complete the following tasks in the order listed:
1. Configure alert notification for problems in the storage subsystem
2. Define hosts
3. Create new storage partitions
4. Save configuration
5. Set/change password
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